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INTRODUCTION 

 
 Face it, folks. eBay is where the money is.  At 
last count, the online auction giant was generating 
$26,000,000 in sales every day.   
 
 Staggering, isn’t it? It’s one thing for a 
software giant like Microsoft to have that kind of 
sales level—I mean, we expect computer geniuses 
to be making the big bucks, right?  But when you 
realize that eBay is made up of a big pool of 
individual sellers, regular people like you and me, 
now that’s impressive!  
 
 Yeah, you heard right.  Regular people like you 
and me can share in eBay’s $26-million-per-day pie.  
This course will show you how to:  
  

• SELL MORE, and make more $$$ on each 
sale.  

• Save over 90% on eBay listing fees. 
• Tantalize every looker with other products you 

have to offer.  This technique will help you 
UPSELL like Crazy. 

• Advertise ALL your goods 24/7 for pennies per 
week. 

• Learn my simple formula for making a picture 
gallery with live links to your eBay store.  My 
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most powerful tool for drawing business to my 
store- and it’s totally approved by eBay : ) 

• Shoot your own sales photos, and get 
professional results. 

• TURN eBay’s linking policy into money in your 
pocket. 

• BONUS: Free insider techniques to help put 
your business on autopilot. 

• BONUS: Free Online Class: “Auction Genius” 
• BONUS: Earn commissions by telling eBayers 

about my e-Book!  Become an affiliate, get paid 
for every referral who buys my book. 

 
 
ABOUT THE AUTHOR 

 
 I’m Marjory Howes and I learned to make 
money with auctions the hard way.  I started 
goofing around on eBay to make a few extra bucks 
from home.  I took one of my artistic talents, 
writing names on grains of rice, and started selling 
personalized rice necklaces to collectors.  Lo and 
behold, the orders starting coming in! 
 
 Let me tell you, it was great for a while.  My 
stuff was selling pretty well, but my eBay invoice 
was taking a big chunk of my profits.  I bet you can 
relate to that, can’t you? 
 

http://pages.ebay.com/help/community/png-links.html
http://www.auctioncashmachines.com/aff.html
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 It took me nearly 2 years of selling my name 
on rice necklaces to figure out how to work the 
system the smart way.  I discovered a way to SELL 
MORE and pay less. 
 
 Let me say that another way:  I sell more items 
while paying much lower listing fees, and you can 

too! 
 
    The secret is using an 
eBay store along with a 

proven system to drive crowds of buyers to it. 
 
 You get to SKIP the learning CURVE!  
 
 I’m going to show you the fast track to a more 
profitable eBay business. After studying this course 
you will be armed with the information you need to 
maximize your own eBay store and turn every 
auction you run into a giant billboard for the rest of 
your inventory. 
 
 If you don’t have an eBay store, you’ll want to 
open one after reading this!  It’s the key to saving 
90% on your listing fees. 
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HOW THE HECK CAN I SAVE 
90% ON LISTING FEES??? 

 
 I know lots of sellers who don’t get an eBay 
store because the subscription fee is $9.95 per 
month.  For some reason, they feel that’s just too 
much money to ask.  I know because that’s what I 
thought at first too.  Then, I took a minute and did 
some figuring.   
 
 Consider this:  You can list one $9.95 item for 
auction for 30 cents.  Add 25 cents for gallery and 
10 cents for a 10-day auction. That’s 65 cents for 1 
item. With an eBay store, you can list 1000+ of the 
same item for 5 cents a month!  
 
 Go ahead-- splurge and add the gallery picture 
for an extra penny : )  I’m not kidding with you-  
gallery pictures for store items are just 1 cent.  I 
love that. 
 
   What’s more, Ebay now has store listings that 
are good until you cancel them, and I say it’s about 
time.  Once you have your mini-gallery and store 
items set up correctly you don’t need the hassle of 
re-listing expired store listings.   
 
 Of course, if you want you can specify a 30, 60, 
90, or 120 day listing that will expire on its own. 
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The 30 – 120 day listings are prepaid, but the 
unlimited ones are charged to your account 
monthly at 5 cents per listing. 
 
   The best part is any storefront listing will be 
5 cents per month NO MATTER how much you are 
charging for your stuff, or how many are offered in 
each listing.  You could list 1000 big screen TVs in 
your eBay store costing $6,000 each and the listing 
would still cost just 5 cents per month.   
 
 Imagine the money you’d save if you put one 
TV up for auction and told customers to BUY IT 
NOW in your eBay store.  That auction would cost 
you somewhere between $3.30 and $4.00 depending 
in whether or not you added a gallery picture and if 
you got the 10 day listing. 
 
 Using my techniques, you can literally 
advertise all 1000 big screens all month long for 
under $12.   It would cost you nearly $4000 to run 
them all as auctions. For more info on eBay’s store 
fees, click Here.  
 
 See why that $9.95 store fee per month is a 
drop in the bucket when you consider the listing 
fees you’ll save? 
 
Now do you see why you NEED an eBay Store?  
 

http://pages.ebay.com/storefronts/pricing.html
http://pages.ebay.com/storefronts/pricing.html
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 The one tricky thing about store listings is 
they won’t come up when someone searches in the 
auctions.  To make sales, you must run some 
auctions, and you must get those auction-goers to 
your eBay store to shop. That’s where a mini-
gallery comes in. 
 
Before we start the tutorials, I’m going to assume 
that you already have some experience on eBay, 
either buying or selling. If not, spend a few days 
browsing in categories that interest you.  Register 
with eBay, and buy something.  Pay attention to 
what sellers are doing well in the listings you see.   
 
 For beginners, I recommend this e-Book, “eBay 
Marketing Secrets 2002.” It’s designed to help you 
get started using eBay.  It will get you up to speed 
on the basics of placing listings.  I’ve arranged with 
the author to give my readers a special deal. The 
book normally retails for $24.95, but you can get it 
for just $9.95 through my website. 

“eBay Marketing Secrets 2002” 
Click the title to get it for $9.95 

 
 
 For those of you who don’t have products to sell 
yet, I have a neat deal for you too.  The author of 
“Wholesale Sources 2002” has given me permission 
to sell his book from my website at a big discount. 
It’s yours for $14.95 instead of the regular $24.97.  

 

http://www.auctioncashmachines.com/ems2002.html
http://www.auctioncashmachines.com/ems2002.html
http://www.auctioncashmachines.com/ems2002.html
http://www.auctioncashmachines.com/ws2002.html


 9 

“Wholesale Sources 2002” 
Click the title to get it for $14.95 

 
 
 I’ll also assume that you use Windows.  If 
you’re a Mac user, I’m sorry that I can’t be more 
specific in instructions for your system.  The basic 
concepts I’ll share apply to Mac users the same as 
windows users, but if you use a Mac you’ll need to 
find Mac software to edit your photos and edit 
HTML. 
 
Essential Tools 

 
• Photo-editing Software like Photoshop or Paint 

Shop Pro to make your gallery photos. You can 
download a free trial version of Paint Shop Pro 
at www.jasc.com.  Chances are, you have some 
kind of photo program already on your 
computer.  Mac users, look for your 
Appleworks or ClarisWorks paint program. 

 
• Online Photo Hosting Service.  Free and low-

cost hosts work fine for this. I use yahoo 
Geocities for $4.95 a month.  If you don’t have 
a service yet,  just go to your favorite search 
engine (www.yahoo.com, www.altavista.com, 
ect) and search for “image hosting”. 

 
 

http://www.auctioncashmachines.com/ws2002.html
http://www.yahoo.com/
http://www.altavista.com/
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• Quality Photos of all your merchandise. Make 
sure they are in either .jpg or .gif formats.  If 
you can’t get a decent photo from the 
manufacturer, you’ll need a scanner or camera 
to take your own photos. (Don’t panic.  You’re going to 
learn how to take great photos in the first tutorial.) 

 
• Image Optimization Tool:  I use GIFBOT, a 

free and easy tool that ‘squishes’ file sizes down 
so they load faster.  Some of my photos were 
taking 12 seconds to load, but Gifbot got them 
loading in just 2 seconds.  Most people won’t 
wait around for 12 seconds waiting for your 
photos to load . . . they’ll shop elsewhere. 

 
 

• HTML Authoring Program like Microsoft 
Frontpage or Netscape Composer.  Frontpage 
comes with Internet Explorer and Composer is 
usually built into Netscape.  Mac Users, try 
Dreamweaver.  Get a free trial version at 
www.download.com.  Before you buy it full-
price, I recommend looking on eBay or 
half.com.  

 
 
 

http://www.netmechanic.com/GIFBot/optimize-graphic.htm
http://www.download.com/
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TUTORIALS 
 
 
TAKING Your Own PHOTOS  
 
 You will need good, clear photos of the stuff 
you are selling in order to make the best of your 
eBay store.   
 
 If your supplier has professional photos that 
you can use, lucky you- use ‘em! If your product is 
being sold on the Internet already, try searching 
Altavista.com for the item.  When you find a good 
photo you’d like to use (be sure it’s not copyrighted) 
simply right click on the photo and save it to your 
pictures folder.  
 
 If you can’t find a good photo anywhere, you 
get to learn to take the photos yourself.  Don’t 
panic! I’ll tell you a really easy way to do it.  
 
 I prefer a scanner for small items and a digital 
camera for larger ones.  (By all means, shop eBay 
for these items!! I got my scanner for $20 on eBay, 
and my digital camera for about $150.  Both would 
have cost me 2 – 3 times that in the mall)  
 
 Of course, you can use a regular camera, but 
remember you’ll have the extra cost of all that film 
and developing.  You’ll be taking lots of photos, so 
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you may want to borrow a digital camera from a 
friend if you possibly can. 
 
Tips for shooting great photos 
 
 How do photographers get merchandise to look 
so great?   
 
 The secret is in the lighting, and NO you don’t 
have to go buy some expensive light kit.  I figured 
out these tricks when I was selling dresses and kids 
formal wear.  Virtually anything looks better under 
soft light, and I found 2 easy ways to get it 
 

o Shoot your photos outside on a clear day 
either before 10 am or after 4pm.  The 
sunlight is softer during these times of day 
because it isn’t so direct. It also cuts down 
on squinting eyes and sharp shadows.   

 
 Chances are, you can find something 
pretty to use as a backdrop outside too.  
I’ve had kids stand in front of my lilac 
bushes, sit in my swing, or sit on the grass 
for pictures, and it looks great. 
 

But let’s say it rains a lot where you live and you 
can’t wait get outside for a few days.  NO 
PROBLEM.   
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o Get a sheet of opaque landscaping plastic 
from your hardware store and hang it over 
the window in one of your sunniest rooms.  I 
like to use my bedroom with south windows 
since there’s plenty of sunshine throughout 
the day in there.    
 
 Make sure your blinds are open all the 
way so the light is only filtered through the 
plastic.  I like to lay down a piece of fabric to 
use as a backdrop and put my items on top of 
it.   
 
 You can experiment with the color of the 
backdrop to see what shows your 
merchandise off the best.   
 
 I used a neutral sort of sage colored drop 
for my kids clothing.  My husband got great 
results with a black backdrop when he sold 
his Nintendo stuff.  It’s really up to you.  
 
 I put my things facing the window so there 
is plenty of light on the front of then, and 
then stand with my back to the window to 
take the photos.   

 



 14 

MINI-GALLERY Tutorial 
 

 
 In my tutorial on building your mini-gallery, 
I’ll take you step by step.  Those of you with 
experience linking photos and working with URL 
links will probably be able to do this without the 
step-by-step instructions.  (TIP: if you are going to skip the 
step by step and go it alone, be sure to link each photo individually 
to a search results page in your eBay store- more on that in the 
last portion of the tutorial) 
 
 You should have all your product photos 
gathered and saved in a folder on your desktop or 
someplace you’ll be able to easily find them.   
 
 Now is a good time to optimize your photos 
so they will load as fast as possible.  Like I 
mentioned earlier, I like the free Gifbot tool offered 
at www.netmechanic.com.  You will be able to 
upload each photo individually and get it optimized 
to your liking.   
 

http://www.netmechanic.com/
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 Gifbot will show you several different file 
sizes, and you choose the one that looks the best for 
the amount of time it will save to download. You’ll 
only have to do this once, so hang in there!  It is 
amazing how much faster your images can load and 
still look great. 
 
 Optimize your photos and save them to your 
picture file.  
 
 Once you have the photos you need and 
optimized to your liking, open your picture editing 
software (Paint Shop Pro, PhotoSuite, Photoshop 
etc).  If you use a different software, make sure it 
will edit and save .jpg and .gif files.   
 
 One warning:  Windows comes with a 
program called “Paint” but it only edits .bmp so it 
won’t work for this project.  If in doubt, remember 
you can download a trial copy of Paint Shop Pro 
(PSP) from www.jasc.com.  Look in their free 
downloads section.  
 
 
Making Thumbnails 

 
The instructions here are written as if you will 
be using PSP to do your photo editing. If you 
are using another tool, the menus will be different, 
but they should still be similar.  Take a few 

http://www.jasc.com/
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moments to look in each menu and see what’s 
there before you start this tutorial. 
 

• Open one of your full-size product pictures, and 
make sure you are viewing it full-size by 
choosing View> Zoom In> 1:1.  

  
• Now from the menu, choose: Image> Resize.  

You will see a box pop-up with several size 
options for you to choose.  Select “Custom Size” 
and make sure to check “maintain aspect 
ratio.”  You don’t want your photo to be 
disproportional, right? Right!  

 

 
 

• See the number boxes just below “Custom 
Size?”  They represent the width x height of 
your photo.   
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 To make a nice-looking mini-gallery you 
will want all of your mini-photos to be the 
same height.  I like my gallery photos to be 
between 75 and 100 pixels high, depending on 
the stuff you are selling.   
 
 All of my gallery photos for CrazyRice 
necklaces are 100 pixels high, but they are tall 
and skinny photos.  If your items are squarer 
try making them 75 pixels high.  
  

• For this lesson, let’s say your items are tall like 
mine. Enter 100 in the second box (height) and 
tab to see the width automatically change to 
the correct number.  Click OK.  

 
• Look at that great thumbnail of your stuff!  If 

you wanted, you could have text on the photo 
too, but you don’t have too.  Most products 
speak for themselves. 

 
 

• Now select “File> Save as” from the menu and 
give this smaller photo a new name. For 
example:  If your larger photo is of a dog and is 
saved as “dog.jpg”, save this new one as 
“dogsm.jpg” 
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• Go back and make a small version of the rest 
of your photos, saving each as a new name.  Be 
sure you don’t save over the original large 
version. (You’ll need the large one for the 
listing in your storefront, and the small one to 
put in your mini-gallery to drive traffic to the 
storefront.) 

 
Great job!  Let’s move on. 
 
 Did you find a free or really inexpensive image 
host yet??  You’ll need it now so you can upload 
these great photos to it.  Remember, to find one, 
just search for “image hosting” in your favorite 
search engine. 
 
 Follow your service’s instructions to upload all 
your full-size and mini photos to their server.  It’s a 
good idea to leave the browser open at the directory 
where your photos are so you can copy their 
locations in the next step.  
 
 
 Okay, cool then, right?  Pat yourself on the 
back because you’re half way through this mini-
gallery thing : )  Take a break if you need to, and 
come back ready to finish up.  
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Building an Image Table 

 
 Now we are going to line these mini-photos up 
and make them link to your store items.  Here’s 
where your HTML software comes in.  As I said 
before, most browsers now come with some kind of 
html authoring built in.   
 
 I use Internet Explorer’s “Frontpage Express,” 
but there are many others you can use.  Netscape 
has “Composer” that does the same thing. Microsoft 
Word 2000 will also create tables and web links.  

 
• Open your HTML software to a new document. 

In the menu choose: Table> Insert Table.  A 
pop-up box will come up asking how many 
rows, columns, alignment, border size, cell 
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spacing, and cell padding.  I bolded the only 
ones you need to worry about right now. 

 
• Enter 1 row, 1 column, and 5 in border size.  

Click OK. 
 

• Now’s the fun part.  You want the html to pull 
the pictures in your mini-gallery from your 
image host and not your hard drive- Let’s start 
linking! 

 
 

 
• Put your curser inside the table, and choose:  

Insert> Image. (You can also just click the 
image icon in the menu bar.) A pop-up box will 
open asking for the image location.  Choose the 
option “from location.” 

 
• Remember that browser window you left open 

after you uploaded your photos?  Go there and 
click on one of your mini-photos to see it’s web 
location, or URL. It will look something like 
this: 

o http://www.geocities.com/crazyrice2002/puppies.jpg. 
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•  Select the picture’s web address from the URL 

address bar and either right click and COPY or 
push ctrl-C to COPY.   

 
• Switch back to the window with your HTML 

program and paste the image location into the 
pop-up box “Image Location” field.  

 
 

• Continue with the same method, placing all of 
your small photos inside the table to look like 
this:  
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• SAVE YOUR WORK!!!  I like to VIEW; 
HTML and save the HTML code into a 
wordpad file.  I name it “Minigallery.txt” and 
save to my desktop.  Put it wherever you will 
be able to find it easily. 

 
HANG IN THERE!! Remember, you’ll only have to 
set up your mini-gallery once and then it will work 
forever, or until you decide to add new products : )   
 
 
Linking to your eBay Store 

 
 Okay, now we have to make the mini-photos 
link to the correct listings in your eBay store.  YOU 
DON’T HAVE to have all your store listings setup 
before doing this . . . we are going to set it up so 
that these gallery pictures will search your store for 
any listing that matches it, even if the store listings 
aren’t up and going yet.   
 
 You DO, however, need to have your store 
subscription setup before we begin the linking.  If 
you haven’t done so yet, go sign-up for your eBay 
store.   
 

Let me take a quick second to explain something. You 
may be wondering why you can’t just link your mini-
gallery photo to the item number of a listing you 
already have going in your store. The answer is that 
you can if you want to.  But, remember if you link to 
a listing that will expire sometime, that link won’t work 

http://cgi3.ebay.com/aw-cgi/eBayISAPI.dll?SignIn&UsingSSL=0&pUserId=&ru=http%3A%2F%2Fcgi6.ebay.com%2Faw-cgi%2FeBayISAPI.dll%3FStorefrontLogin%26usage%3D0%26userid%3D&pp=password&pageType=866&i1=0
http://cgi3.ebay.com/aw-cgi/eBayISAPI.dll?SignIn&UsingSSL=0&pUserId=&ru=http%3A%2F%2Fcgi6.ebay.com%2Faw-cgi%2FeBayISAPI.dll%3FStorefrontLogin%26usage%3D0%26userid%3D&pp=password&pageType=866&i1=0
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anymore!   You will have to go back to your mini-gallery 
code and re-link to a current item.  On the other hand, 
if you follow my instructions and link to a search 
results page in your store, as long as there’s a listing in 
the store that has the right search terms in the title, 
the link will go to that item.  This method also allows 
you to show all the items with the right search terms in 
it.  
 
 If that was confusing, see if this example makes 
more sense. 
      Example: I have my mini-gallery photo of a dolphin 
necklace linking to the search term “dolphin” in my 
eBay store. Now, anyone who clicks on the dolphin 
thumbnail will see what’s in my store this week with 
dolphins.  Any store item that has ‘dolphin’ in the title 
will be displayed to my customer.  If I decide I want to 
change the color of beads on the dolphin necklace, I can 
end the old listing and start a new one without 
worrying about updating the mini-gallery link.  Make 
sense? 
Okay-  back to the tutorial. 
 

  
 
 Open a browser window to your eBay store 
main page.  Near the top and to the right is a 
search box.  Uncheck “Search titles and 
descriptions.”    
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 We are going to make your first gallery 
picture search for any related listings in your store. 
If your first photo in the gallery is a leather purse, 
type “leather purse” in the search field.   
 

 
 
 When the search results come up, look at the 
URL address bar.  It will look something like this:   

 
http://search.stores.ebay.com/search/search.dll?
MfcISAPICommand=GetResult&sid=5708382
&store=Crazy+Rice+n+Kids+Boutique&colorid
=7&fp=0&query=leather+purse 

  
• Notice these important parts of the address:   

o 5708382 is my eBay store number.  Your 
eBay store will have its own number that 
will be here.  

o Crazy+Rice+n+Kids+Boutique is the name 
of my eBay store.  The name of your eBay 
store will be here. 

o leather+purse  is the phrase I searched for 
within my eBay store. 

 
• All you have to do to have the system search 

for your other store items is replace the purple 
search terms with new ones,  SOOOOO . . .   
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• Select and Copy that long, ugly address we 
just got after searching for leather purse. 

 
• Switch windows back to your html software 

and double-click your first mini-gallery photo.  
 

• Paste your long, ugly search results address 
into the default hyperlink field. 

 
 

• SHORTCUT - to save time of linking the rest of 
the photos to their correct search results, 
PASTE that same long address into the default 
hyperlinks of the rest of your mini-gallery 
photos.  

 
• GREAT TIME TO SAVE AGAIN . . .  

 
• Now, go back and double click the second 

photo.  In the default hyperlink field where you 
pasted the long address, just replace the search 
terms at the very end of the address with the 
correct terms.   
 
 For example: If your second picture is of 
leather gloves, edit the long hyperlink address 
to say “leather+gloves” at the end instead of 
“leather+purse” 
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• Double click the rest of the gallery photos and 
update their search terms to match each mini 
photo. 

 
• SAVE IT AS A .TXT FILE.  From the menu 

choose: View> HTML (or source).  Select all the 
HTML text coding and save it as a .txt file 
using wordpad or another word processor.  

 
 
 You should now have a mini-gallery of photos 
that link directly to a search results page in your 
eBay store!  If you’ve done everything correctly, 
each photo will link directly to all the items in your 
store that have the specified search terms in the 
title. (NOTE:  If you haven’t listed all of your store items yet, be 
sure to do so before you start running auctions with the mini-
gallery. Otherwise, nothing will come up when customers click the 
photos) 
 
 Now, if you’d like, add some text to your mini-
gallery such as “More items available to BUY IT 
NOW in my eBay store!” or “Get a FREE BONUS 
when you shop my eBay store for these other items” 
(See the Keyword Spamming warning section) 
 



 27 

 
 
 
 
RULES OF THE GAME 

 

Beware Keyword Spamming: 
http://pages.ebay.com/help/index_popup.html?p

olicies=listing-keywords.html 

 The idea behind eBay’s keyword 
spamming policy is to keep sellers from taking 
unfair advantage of the eBay search feature.  
Basically, you may not pack your item 
description with a bunch of unrelated brand 
names or keywords that are not for sale in that 
auction.   

 I learned about the Keyword spamming 
policy by accident.  When I first started selling 
my “Name on Rice” necklaces, I mentioned all 
of the styles I had available in every auction I 
had.  In my auction for a horse necklace, I said, 

http://pages.ebay.com/help/index_popup.html?policies=listing-keywords.html
http://pages.ebay.com/help/index_popup.html?policies=listing-keywords.html
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“I also carry fish, crosses, dolphins, turtles, 
cats, dogs, and unicorns.”  

 It wasn’t long before I got a not-so-polite 
email from eBay telling me that I was breaking 
their Keyword Spamming policy and they 
ended all of my auctions.  

 Please be careful when writing your 
descriptions!  I still wanted to tell my 
customers that I had tons of other styles, so I 
came up with the mini-gallery idea. My 
customers can see my other products without 
my saying (or typing) a word : )   

 This is perfectly legal because it doesn’t 
interfere with the search feature, yet the 
photos still advertise my other products.  You 
can use this method when up selling in your 
listings too.   

 I started putting a photo of matching 
earrings into my necklace listings, and saying, 
“Get matching accessories in my eBay store.”    
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 I didn’t 
say, “Get 
matching 
earrings” 
because that 
would be 
keyword 
spamming.  
EBay will 
allow you to 
say 
“accessories,” 
but you cannot 
say “earrings” 

unless you are selling earrings in that auction.   

  
Also Beware of eBay’s Linking Policy 

 
 
 http://pages.ebay.com/help/community/png-links.html 
 

 My mini-gallery is in accordance with 
eBay’s linking policy, but it’s a good idea to 
read through the policy so you are aware of 
what you cannot do.  

  
 

http://pages.ebay.com/help/community/png-links.html
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SUPER SELLER TIPS 
 

• Don’t offer BUY IT NOW directly in your 
auction, because when one person buys it now, 
the auction is over!  Remember, these little 
auctions are mainly ads to get people to buy 
from your store.   

 
 Instead, make it clear that shoppers can 
BUY the same item NOW in your eBay store 
and give them the link.  If you got the buyer to 
your eBay store to make their purchase your 
auction is still going, and drawing more buyers 
around the clock.  
 

• Sell inexpensive items at auction when 
possible.  The lower your minimum bid, the 
lower your listing fee. Studies show that more 
people look at less expensive items.   

 
 Everyone loves a bargain, and you want 
anyone interested in your product to think, 
“Hey, I can afford that!” You want everyone to 
look at YOUR listing because then they will 
see all the related items that are in your store.  
 
       A good friend of mine uses this method all 
the time and has great results.  Her name in 
Sydney Johnston, and she showed me how to 
take a $1 item draw in thousands of targeted 
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shoppers.  The lady has some amazing ideas-  
more on her in just a minute . . . 
 

• Feature your hottest item, and let it drive 
customers to your other listings through your 
mini-gallery.   

 
• Run all your regular auctions for 10 days.  It 

costs an additional 10 cents, but well worth the 
extra time that listing will draw targeted 
buyers to your store. See how just three 10-day 
auctions give you an ad on eBay an entire 
month? 

 
• Make shopping in your eBay store EASIER or 

more rewarding than bidding in the auction:   
o Offer reduced or free shipping on eBay 

store items 
o Offer a FREE BONUS with items bought 

from eBay store. 
o Offer package deals in your store.  Ex: 

Camera starter pack with a special price. 
o Offer to combine shipping on items bought 

in the store. 
 

• Pick related items to sell in your store and 
auctions. If you sell digital cameras, sell more 
memory, camera bags, and photo software in 
your eBay store.   
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What else can I sell in my eBay store??   

 
• Services: Offer gift-wrap service for your 

products in your store.  This is big at 
Christmas time, but also works great for 
Valentines Day, Mothers Day, etc.  

 
• Accessories to your auction offerings.  Sell 

rechargeable batteries in your store if you sell 
electronic gadgets.  If you sell DVDs, offer a 
scratch repair kit, software to organize your 
DVD collection, maybe even movie posters. 

 
 

• Digital products that customers can 
download.  This is my favorite!  There’s 
nothing to pack and ship, and delivery is 
immediate as an email attachment or instant 
download. Write your own product, or sell 
someone else’s and get paid commission. 

 
 That brings me to my affiliate program. 

o List my eBook “Turbo-Charge your 
Auction Store” in your eBay store and I’ll 
split the profits with you 50/50.   

 
 Set it up once, and you’re done! 
There’s no better way to get stared in 
selling digital products than this. You’ll be 
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able to see for yourself how much easier 
selling digital products is than packing 
and shipping.   
 
 In fact, that’s how I got started with 
digital products- selling other authors’ e-
books for commission. I’ll provide you the 
sales copy, book cover photo for your mini-
gallery, and show you how to get set-up 
with my affiliate program software so your 
commissions are automatic.   
 

To get started now, visit my website: 
http://www.auctionsalesmachines.com/aff.html 
o You will be amazed at how much easier 

making money is with digital products.  
Eventually, you may want to write your 
own!  Until then, there are thousands of e-
Books out there that are available for you 
to re-sell for a good profit.  If you hate 
shipping, this is the perfect option for you.  

 
 
PUTTING YOUR BUSINESS on 
AUTOPILOT 

 
• Subscribe to a service that sends out your 

winning bidder notifications for you.  I like 
Auctionwatch because it has tons of features to 
help you sell, get paid, ship, track, leave 

http://www.auctionsalesmachines.com/aff.html
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feedback, and follow up easily.  I also like 
Auctionwatch because I can set it up to insert 
my mini-gallery into EVERY listing that I run.  
CLICK HERE for a FREE 2 week trial. 

 
My favorite thing about AuctionWatch is its re-
curring auction feature.  It will launch auctions for 
you over and over so you don’t have to do it by 
hand!  It also has a feature that will place static 
information into your auctions.  For example, 
anything that you say in every auction you run can 
be set-up to just go in automatically.  By all means, 
use that feature to put your mini-gallery into every 
auction you run.   
 
   I used Frontpage to make a simple page with my 
mini-gallery and all of my policies on it.  Then, I 
copied the html into Auctionwatch.  That way, AW 
put that info into every listing without me having 
to type it all over and over.  
 
Another thing that will help you automate your 
business is using autoresponders.  If you start 
getting emails from buyers that all have the same 
questions, make up a FAQ file and put it on an 
autoresponder.  You can then mention the 
autoresponder in your store and auction listings.   
 
Of course, there are tons more ways to use 
autoresponders.  If you want more information on 

http://www.auctioncashmachines.com/AuctionWatch.html
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them, checkout “Auto-responder Magic.”  It is full 
of ideas and templates that you can tailor to your 
own business.  Email me for more info on that e-
Book, or you can usually find it for sale on eBay. 
  
For more in-depth information on how to make 
your business run itself, check out my friend, 
Marlon.  He’s a really nice guy with tons of 
experience building Internet businesses that run 
themselves.  He will share some of his best secrets 
with you for FREE.  Check out his website 
"Automate Your Web Business" and look for the 
pop-up ads that offer a free email course.  
 
    
Taking your Auction business to the next 
level 

 
     Remember my friend Sydney I mentioned 
earlier?  She’s the one who taught me how to turn a 
$1 product into thousands of customers.  She also 
inspired me to write this eBook, and it has honestly 
changed my life.  

     Sydney has been doing business on eBay since it 
was brand new and like I said, she really knows 
her stuff. 
    

 I highly recommend Sydney’s AUCTION 
GENIUS© Course .  Every student will take one 

http://www.auctioncashmachines.com/Automation.html
http://www.auctioncashmachines.com/auctiongenius.html
http://www.auctioncashmachines.com/auctiongenius.html
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product and understand how to turn it into a 
profit center. Just one product.  

Doesn't even matter how much money you make.  

 Because once you understand the 'how-to", the 
method, then all you have to do is add products or 
increase your per product/profit, to reach 
whatever amount of money you wish. And you are 
independent of anyone else. 

Finally! 

Listen to a FREE online class 

"The AUCTION GENIUS© Course: Triple Your 
Profits In Half The Time" 

right on your own computer, anytime you 
wish. 

 
 In closing, I’d like to wish you the best of luck 
in all your Internet endeavors!  I spent thousands 
of dollars on other business opportunities, but 
never made a cent until I found eBay!  It has truly 
changed my life and I know you too can make a 
profitable business using the eBay store techniques 
I outlined in this book. 
 
 I truly hope this information has given you 
some new insight to marketing on eBay!  I’d love to 
hear how your sales go when you get your mini-
gallery and eBay store working together! 

http://www.auctioncashmachines.com/auctiongenius.html
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Drop me a line at 
mailto:marjory@auctioncashmachines.com 

 
 
FREE UPDATES 

 
 
 This e-Book comes with free updates for life.  
You can check for the newest version at this link: 
www.auctioncashmachines.com/update.html    
 
In the mean time, keep selling, and keep learning! 
 
Best Regards,  
Marjory Howes 
www.auctioncashmachines.com 
 
PS: You are personally invited to become an active 
participant in my e-Zine “Saavy Auctioneer” and to 
submit your ideas so others can be inspired by your 
success. To sign-up, visit 
www.auctioncashmachines.com  
 

mailto:marjory@auctioncashmachines.com
www.ebaycashmachines.com/update.html
http://www.auctioncashmachines.com/
www.auctioncashmachines.com 
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